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Document Template Editor Introduction

The Federal SACWIS requirements mandate that State SACWIS systems, such as
Social Services Information Systems (SSIS), possess the ability to generate and
maintain documents. Documents include service plans, case notes, checklists,
letters and other documents that are stored in the database.

The purpose of document templates is to allow agencies to create document
templates to supplement the state documents provided within SSIS. State
document templates and state document categories can only be created, edited or
deleted by State Users.

SSIS can insert case data directly into documents and all service plans with its
autofill feature. The template editor allows the agencies to use the autofill feature
in custom templates. The template editor provides the ability to insert fields into
a template. Those fields include document elements, agency and workgroup
merge fields. An element is an HTML element such as a checkbox or text area. A
merge field is an element that gets its contents from the SSIS database, for
example, a client’s name or address. An agency address is an example of an
element that can be included on a template.

Security Administration

A user with the assigned function of Create Document Templates can view, edit,
delete or add document templates and categories.

There is an additional security function that is not available in SSIS
Administration. If you are trained in JavaScript and need this access, contact the
SSIS Help Line.

A user with the assigned function of Edit Document Template HTML can:
e Create custom style sheets
e Have the ability to use style sheets
e Enter answer sets
e Add/edit prompts
e Add conditions.

@Warning: Use caution when assigning the role, Edit Document Template HTML.
Only staff who know and work with HTML should have this role assigned since any
changes could potentially corrupt active templates.
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Access Document Template Editor
Document Template Editor function is accessed from the Tools menu.

Tools Menu
& S5IS Worker/Fiscal - 5.5.1.285

File View Searches/Logs WEEEN Window Help

= I S S8 Document Template Editor
@ External Documents
Reassign Warkgroups, ..

General Reporks

L, 5515 Administration

& 5515 Adoptions

e 5515 Analysis and Charking
THE 5515 Repository

To Access the Document Template Editor:

1. From the Tools menu on the Windows toolbar, select Document
Template Editor.
2. The Template List displays.
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Template List

The Template List displays the agency custom templates and the state pre-loaded
templates. Also, this is the place to begin creation of a new template. Template
properties can be viewed by selecting a template in the grid. A template begins
in draft status. Once a template is completed change the status to active. It
becomes available to agency users in Chronology. Templates can be inactivated if
they are no longer valid templates. For example, an inactive template remains in
the system to reproduce any documents made with that version of the template.

To locate a template on the Template List, use the scroll bar or the type-ahead
feature if the name of the template is known.

The template properties can be changed without opening the template. An
agency can associate a new header or footer template to an existing template
from the template properties screen. This is where users can activate or
inacttivate a template.

The template status determines which fields you may edit on the Template
Properties screen. Document Template Creators are not allowed to make changes
to an active template, if that template has been used by workers via Chronology.
Template properties can be changed on a draft template.

Template List

m Template List

5 = E] FRCe]

|Template Mame ‘Status |Category |Type |Graup |Document Templel:l
Renetta's Template Screen Shot | Draft Child Protective Services Wworkgroup Local agency 10087403
>@ General Lettersihiotices orkgroup Local agency 10085136
Renetta's test Draft Headers/Footers Headers/Footers  |Local agency 10090592 —
Renetta's Test Draft Flacement t/orkgroup Local agency 10085131 El
Template

Document template # Type:

Group: Category | J
MNarme: |

Format: | J
Document identification; | Create date ’7
Status |I”‘3E““’E ﬂ Status date:

Last edited by: | Last changed date: ’7
Deseription:

Layout

First page header. | J
Subzequent header: | J
First page footer | J
Subsequent footer: | J
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To Create New Template Properties:

1. From the Document Template Editor toolbar, click the New Template
button.

From the Template detail screen, select the template type from the Type
drop-down menu.

N

Select a category from the Category drop-down menu.

Enter a template name in the Name field.

Select a format in the Format drop-down menu, if applicable.

Enter a document identifier in the Document identification field, if

applicable.

Enter a description of the template in the Description field.

Select applicable layout features in the Layout section.

9. Click the Save and Open button on the Document Template Editor
toolbar.

10. The Template Editor displays the template.

SANBS NN

® N

To Edit Template Properties:

&

1. Select a template from the Template List grid.
2. Edit fields as appropriate.
3. Click Save.

OHints:

o The Template Properties screen can also be viewed and edited from the Template
Editor on the Template Properties tab.

o Template creators can have two active templates with the same name as long as
the category names are different.
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Document Category

Document categories are used to group templates. There are state categories that
are already pre-loaded and cannot be edited or deleted. Agencies should
examine whether they would like to add categories if no state category exists. An
agency category can be deleted, but only if it is not associated with a document
in Chronology.

Once complete, the new category can be selected on the Template Properties
screen for templates that belong in this category.

Document Menu

ssis File Edit  Format Feeiyl=G08 Tools Window Help

E E Document Cakeqgory Liskt ‘

Template Lisk

| ITempIaI:e Mame

Access Document Category List:

Access the Document menu from the Windows toolbar.

Select Document Category List.

The Document Category screen displays the grid screen and the
document categories properties.

ey
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Document Category Screen

m 5515 Document Template Editor, - 53.5.1.28% - [ocument Category] i _ ﬁ
ssi5 File Edit Format Document  Tools Window  Help - X
HEl® R -
Category Dezcrption Category Qwner | Document Category # |:|
|| inor Parentz Local agency 29
| |Minar Parents State 7
|| Placement Local agency 26
|| Placement State 4
|| Flacement - [Chwia, Local agency
Placement - ICWwWA, State
(Y Fenetta's Child Wwelfare Test Categary Local Agency
Document Categon '
Document categony §#: | Cateqaory owner:

Categony description: |Henetta's Child welfare Test Category

To Create a New Document Category:

Access the Document menu from the Windows toolbar.
Select Document Category List.
Click the New Document Category button or right-click and select

New Document Category.
4. Enter the category name in the Category description field.
5. Click the Save button.

on =

To Delete a Document Category:

Access the Document menu from the Windows toolbar.

Select Document Category List.

Select the document category to be deleted.

Click the Delete Category button right-click and select Delete Category.

&

A Warning diaglog box displays to confirm the action.
Click the Yes button.

o o %wwe@f
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Page Setup

Use Page Setup to change the print settings of a template. The default style sheet
for the template is created when the template is saved. The user may choose to
create a template with different page setup options. E.g., changing the
orientation from portrait to landscape.

Page setup changes made from the Template List become the default for all of
the agency templates. Workers should change the page setup for a specific
template while in the document template editor.

Page Setup Screen

Page Setup

Orientation kargins [inches]

o Foi | Let| 1B migw [ 157

.................

" Landscape | Top 1E|: B attam; 1E|:

Fant

|. Black j |Times M ew Foman j |'|2|:|t j

Restore Defaulkz | Cancel |

To Change the Page Setup for All Documents in the Template List:

From the Template List, select the File menu on the Windows toolbar.
Select Page Setup. The Page Setup screen displays.

Change the page setup options to enable the OK button.

Click OK.

pon =

To Change the Page Setup of an Individual Document in the Template List:

@’D

1. From the Template List, double-click on the document template, select the
File menu on the Document Template Editor toolbar.
2. Select Page Setup. The Page Setup screen displays.

3. Change the page setup options to enable the OK button.
4. Click OK.
Social Services Information System (SSIS) Version 5.5/Version 11.3 FINAL
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OHints:

e Ifusing a specific template, users should save a copy of the template at least once
prior to changing the page setup on that template.
e Headers/Footers autocalculate based on the template margins.
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Document Elements

There are numerous elements available in the editor. These elements include
Check Boxes, List Boxes, Images, Input Boxes, Text Areas and Date. The
Document Template Creator enters these elements that allow the worker to select
or enter information directly into the template in Chronology. For example,
workers can only type in areas designated by text areas and input boxes.

Each element is a distinct data element and must be uniquely identified in the
tree for it to work properly. Users cannot copy and paste document elements in
the template editor. Otherwise, a warning message displays stating “This
element cannot be copied”. However, there is a Copy Field feature that allows
users to copy and rename an element.

Refer to the Create a Set of Document Elements section of this module to create
multiple elements.

After creation, elements are represented in the Tree View by blue nodes labeled
with abbreviations for the type of element represented.

Abbreviation | Document Element Type Tree View Nodes
CB Check Box CB

LB List Box LE

IMG Image IMG

I Input I

TA Text Area TA

DT Date 01
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Check Boxes
Some agencies have used lines or boxes where users could type an X. The editor
uses a standard Windows check box.

Document Template Creators must enter a description for a check box in the
Label field and identify whether the check box should default to Checked or
Unchecked.

Old Check Boxes

Mental Health Service WNeed

Use of Drugs or Alcohol

OA. Yes

OB. No __ Vocational Functioning

Individual characteristics

|
|
| ”C‘ng'ﬁ're bias to attribute hostile intent tq
|
|

Favorable attitudes toward problem behsz

Psvchiatric symptomatology Psvchopathy

”Subitance abuse

”Limited leisure recreational ivolvement

New Check Boxes
H¢ & B I UE = &
& B e |. Black j |Times Mew Roman j |12ptﬂ

EH Document
» State language black
FPB Forced page break,
=1+ Elements
€6 Check Boxl
€6 Check Boxz

i
il
[
[l
amn
[l
¥
]
[Ta]
"W
L2
%

1

11

i

Editar HTML Preview Template Properties

(] Workgroup [ Mental Health Service Need
[ Use of Drugs or Alcohol

[ Wocational Functioning
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Add Document Template Field - Check Box

Eﬁ Add Document Template Field

Properties [#alues
Label “heck Box 1
DeFaule hat

fohecked
[Unchecked

(=] —ancel

To Insert a Check Box in a Template:

Right-click on the Elements folder.

Select Add Field.

The Add Document Template Field screen displays.

Click in the box in front of Check box.

Enter an identifier under the Values column in the Label field.

Select whether the check box should default to Checked or Unchecked in
the Default drop-down menu.

Click OK.

The new check box displays in the Tree View.

Drag and drop the new check box into the document.

© @ N ?\W%PNHQ\Y
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List Boxes

List boxes allows a fixed selection of text for the document and can be used any
time there is need for the user to select one item from a list. For example, a list
box may include an option to select mother, father, grandparent or sibling from a
drop-down menu.

List Box

Mo
Sometimes

Add Document Template Field - List Box

[ﬁ Add Document Template Field

Check box
Image
Input
Texk area
Date
Properties |'u'a|ues
Label Crop-down menu options
Cpkion [=]fes
Option Mo
Opkion Somekimes
poete opion | [(atBefauk | acdopton | ok | carce
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Insert List Boxes in Template:

Right-click on the Elements folder.

Select Add Field.

The Add Document Template Field screen displays.

Click the box in front of List box.

Enter a name for the list box in the Label field.

Type a drop-down menu option in the Option field.

Click Add Option.

The Add List Option box displays.

Type in the next option.

10. Click OK.

11. Repeat steps 6-8 for each additional option in list.

12. If a default display option is desired, click on the option and then
click Set Default.

13. Click OK.

14. The new list box displays in the Tree View.

15. Drag and drop the list box into the document.

@mﬂ@w%wwe@\y
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Text Area

Text areas should be in documents whenever large amounts of text are to be
entered. The worker has unlimited characters available to enter in information.
For example, the worker may need the ability to enter a summary that may be
three paragraphs in length verses entering a couple sentences in the document.

Old text areas are represented in old document templates as big spaces, generally
preceded by an in-template prompt. In old templates, users could type anywhere
on documents.

There is a scrolling option that allows text to wrap. If no selection is made in the
Scrolling Values field, this field defaults to Auto. Thus, it automatically allows
the text entered to scroll or wrap in the text area. The text area height and width
default to a standard size if no values are chosen.

Template creators should not type information or labels into a text area as it will
not save, or be visible, to the user of the template.

Old Text Area

[ have the following thoughts:

[ would also like to go into great detail about the fn:l]lnwing:|
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Text Area

I have the following thoughts:

I would also like to go into great detail about the following, which is whv [ put in a scroll bar:

[

Add Document Template Field - Text Area

[E Add Document Template Field

Check box
List box
Image
Inpuk
v _
Date
Properties Walues
Label Text Area 3
wideh 100
Height 100
Frameborder o -
1
Scrolling Ve
Mo
Auko
(] 4 | Zancel |
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Insert a Text Area in Template:

Right-click on the Elements folder.

Select Add Field.

The Add Document Template Field screen displays.

Click in the box in front of Text area.

Enter a name for the text area in the Label field.

Select a Width and Height if desired in the Width and Height fields.
Leave these fields blank if default settings are appropriate.

Select the desired frameborder option from the Frameborder Values
drop-down menu.

N .O\.w.%.wwe@\y

e Select 0 to have no frameborder around the text area.

e Select 1 to have the frameborder displayed around the text area.
8. Select the desired scrolling feature for the text area in the Scrolling field.
9. Click OK.
10. The new text area displays in the Tree View.
11. Drag and drop the text area into the appropriate place in the document.
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Images

Images can be inserted in the document. The image can be imported from saved
images on the agency network. Certain files such as Portable Document File
(*.pfd), Microsoft Office Open XML (*.docx) and others are not supported in the
editor. To add a supported image file, users should select an image with a file
extension of JPEG Image File (*;jpg.), JPEG Image File (*.jpeg), PNG graphics
from DevExpress (*.png), Bitmaps (*.bmp), TIFF Images (*.tif), TIFF Images
(*.tiff), Icons (*.ico), Enhanced Metafiles (*.emf) and/or Metafiles (*.wmf).

The default Height and Width is 100% and can be resized once the image is
entered into the document. The height and width is entered as a percentage
and/or pixels. Pixels is the default for these fields. To indicate a percent, type %
behind the value.

Image

This is my cat, Mouse.

Insert Image in Template:

Right-click on the Elements folder.

Select Add Field.

The Add Document Template Field screen displays.

Click in the box in front of Image.

Enter a name for the image in the Label field.

Click in the Image Source field.

The ... button displays.

Select the ... button to open the browser or click the Source button on the

bottom to select an image from a file.
Enter the height and width in the Width and Height fields.

e @NQP‘&P@NHQY
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10. Click OK.
11. The new image displays in the Tree View.
12. Drag and drop the image into the appropriate place in the document.
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Input

There are many instances in document templates where the user needs to type a
small amount of free text. Enter a prompt to tell the user what they should enter
in the Input field. For example, the Document Template Creator can type “Enter
allegation here” to direct users in how to use the field.

Users are limited to 256 characters in an input field. Use a text area described
previously when large areas of free text are desired.

Below are examples of past input options for users verses the New Input field:

Worker had In-text Designation for Input

Please mclude %[Child 1 Name]'s full name, %[Child 1| Name]'s date
of birth, vour full name, vour position as the residential facility
representative, the name of the residential facilitv that vou represent,
%[Child 1_Name]'s case number. which is (weskey include the case
numbier and any effiex identifying infovmation necessavy fox the
ceunt administuatey te accept te infovmation and submit it fo a
judge with the agency's wepext) and information that vou want the

Worker had Short Line to Type Over

Behavior problems: (tvpe)
Other:

New Input Field

Behavior Problems: |1"_pr
Other: |

Insert Input Field:

&

1. Right-click on the Elements folder.

2. Select Add Field.

3. The Add Document Template Field screen displays.
4. Click in the box inf ront of Input.
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5. Type a label in the Label field so that the field can be identified in the Tree
View.

6. Select a width in the Width field, or leave blank to resize in the document.
7. Type a prompt for the user in the Value field, if desired.

8. Click OK.

9. The Input field displays in the Tree View.

10. Drag and drop the Input to the appropriate place in the document.
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Create a Set of Document Elements

There are instances where the user may want to create several elements at once.
Use Create Element Set to create multiple check boxes, input boxes and/or text
areas. The Tree View displays multiple elements with a unique identifying
number. The text typed in the Label field gets a number added to the end of it
when the element set is created. For example, if the desired label is CB01, type
CB in the label and it will become CBO1.

The values entered on the Create Element Set screen apply to all items created.
For example, the user wants 50 check boxes with 40 checked by default and 10
unchecked. In this situation, the user selects Checked as the default, and then all
50 check boxes are checked.

The maximum number of document elements that are created at once is 1000.

Create Element Set Screen

m Create Element Set

Element Tvpe
{» Check box " Input " Text area

Element Info,

How rnary: |5 ﬂ
Propetties |'-.-'a|ue5
Label Check Boxes-Checked
Default | -
_hecked
Unchecked

(04 Cancel

Insert Multiple Document Elements:

@’;

1. Right-click on the Elements folder.

2. Select Create Element Set.

3. The Create Element Set screen displays.

4. Select the desired Element Type: Check box, Input or Text area.
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5. Enter the number of elements desired in the How many field.

6. Type alabel in the Label field so that the field can be identified in the Tree
View.

7. Enter additional properties:

e Check box - In the Default field drop-down menu, select whether
the check box should default to Checked or Unchecked.

e Input - Select a width in the Width field, or leave blank to resize in
the document. If desired, type a prompt for the user in the Value
field.

e Text area - Select a Width and Height if desired in the Width and
Height fields. Leave these fields blank if default settings are
appropriate. Select the desired scrolling feature for the Text area in

the Scrolling field.
8. Click OK.
9. The new Check box, Input and/or Text area fields displays in the Tree

View.
10. Drag and drop the Check box, Input and/or Text area fields to the
appropriate place in the document.
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Template Editor

The Template Editor is where the body of the template is entered and where the
document elements and merge fields are dragged from the Tree View into the
Editor to create or update the template.

There are four types of documents available in the editor. The Headers/Footers
template allows template creators to create agency letterhead. The Service Plans
template allows the template to function like a service plan and is located in
Chronology. The Workgroup template provides the means to create several data
elements such as check boxes, input fields, text areas and merge fields. While the
Style Sheets template is used to control the page set up options using HTML
language.

Style sheets do not display on the template properties screen as a Type unless the
user has the security administration rights of Edit Document Template HTML.
Agencies that do not have staff who write custom HTML should use page setup
to edit the page settings such as orientation and font.

Template creators can only create local agency templates. Therefore, the Group
tield defaults to Local Agency. The template status defaults to Draft, until the
template creator activates or inactivates the selected template.

The Create date, Status date, Last edited by, and Last changed date fields all
autofill.

The appearance of the Tree View varies based on the template type selected on
the Template properties screen. For example, if the template type of
Headers/Footers is selected, an HF icon displays in the Tree View.
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Template Editor
m 53515 Document Template Editor - 5.5.1.292 - [Template Editor for Renetta’s Test A] |Zl|ﬁ|rz|
{sic File Edit Formak Document Tools Window  Help -8 x
BlhE BRiRE B I U S=E=E=|SiE|EE|v o Mo -
= B Document Editor IHTML ] Preview ] Template Properties
+ State language black
FPe Forced page break =
=] Elements
5 Agency
5 Warkgroup
THIS IS THE SSIS TEMPLATE EDITOR
[
Create New Template Button
Save and Open Template Editor Button
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Template Type Equal to Headers/Footers

Template Type equal to Headers/Footers allows agencies to create header and
footer templates that contain agency information. For example, a header or footer
template can be used to create an agency letterhead.

Once a header or footer template is created and activated, a header and/or footer
can be selected as the header or footer for other local agency templates. Also, a

header/footer template can be associated to some state templates.

Document Template Editor with Template Type Equal to Headers/Footers

E 5315 Document Template Editor - 5.5.1.285 - [Template Editor, for Renetta’s Test Headers/... f| El&|
ssté File Edit Format Document Tools  Window  Help

H & B2iRg =i

=B Document Editar IHTML ] Preview ] Template Properties
HF Current page

HF Taotal pages
HF Print date

HF Prink Lime

HF Template name

HF Document identification
] Elements

To Create a New Header/Footer Template:

@’;

1. From the Template List’'s Document Template Editor toolbar, click the
New Template button. A new, blank template displays in the grid and a
new Properties screen displays below.

Select Headers/Footers as the Type from the drop-down menu.

The Group field defaults to Local Agency.

The Category defaults to Headers/Footers.

Enter the template name in the Name field.

Enter Document identification, if applicable.

The Status field defaults to Draft.

NSl LN
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8. Enter a description of the template in the Description field, if applicable.

9. Click the Save and Open button.

10. The new template displays in the Template Editor.

11. Drag and drop appropriate merge fields and elements in the editor in the
location they should display in the template.

12. Click Save.

OHints:

o If the document Type is set to Headers/Footers, the Format field is disabled on the
Template Properties screen.

e The Orientation and Margin (inches) fields are disabled on the Page Setup screen
for templates Type of Headers/Footers. The Orientation and Margins (inches) for
headers/footers are determined by the template that it is associated with.

Change Headers/Footers

Change Headers/Footers allows template creators to swap one header and/or
footer with another header or footer. This change becomes effective on all
templates associated with the header or footer. Once a Headers/Footers template
is changed, the change becomes effective from that date forward. This is not a
retroactive process. Documents already created with the previous
Headers/Footers do not lose the original. For example, the agency created a
template that is associated to an agency letterhead template. The agency moves
location and needs to update its new address on the header template and all
templates associated with that old letterhead.

Change Headers/Footers Screen

[ﬁ Change Headers/Footers

Feplace Header/Footer:
| Renetta's Header 3/5/410 - Active j

with Header/Footer:

Social Services Information System (SSIS) Version 5.5/Version 11.3 FINAL
Training Module: Document Template Editor Page 28 of 53



SSIS Training

To Change Headers and Footers:

&
1. Click the Tools menu on the Document Template Editor toolbar and select
Change Headers and Footers.
2. Select the header or footer template to replace from the Replace
Header/Footer drop-down menu.
3. Select the new header or footer template from the With Header/Footer

drop-down menu.
4. Click OK.

Setup State Template Header/Footer

Setup State Template Header/Footer allows the template creator the ability to
add an agency letterhead to certain state templates.

SSIS has predetermined which state templates can have a local header. This
option is not available for state templates with an existing header. It is disabled
on the Setup State Template Header/Footer screen.

The State Templates section autofills with the names of the state templates
available based on the option selected.

If SSIS revise a new version of a state template, agencies will have to add agency
headers to the new state templates again. If agencies use more than one header
template for state documents, keep a cheat sheet for future reference as to which
state template gets which header attachment.

Use Change Headers and Footers to edit header or footer associated with certain
state templates. However, if a change is not needed on all templates, contact the
mentor to request a database change from SSIS.
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Setup State Template Header/Footer Screen

:ﬁ Setup State Template HeaderfFooter

Header/Foater Type
i+ Firzt Page Header i Subsequent Header " First Page Footer " Subsequent Footer

Local &gency Header/Footer

|F|enetta's Header 2/26/10 j

State Templates

Fenetta's Child “Well Being merge fields TABLE 2
Fenetta's Child “Wel Being merge fields TABLE 3
Fenetta's Report to the Court 3

Ol Renetta's Social Worker Checklist - [C0w and MIFPA 3

QK. Cancel

To Add a Header or Footer to a State Document:

1. From the Template List toolbar, click the Tools menu and select Setup
State Template Header/Footer.

2. Select the applicable header or footer option from the Header/Footer Type
field.

3. Select the agency header or footer template from the Local Agency
Header/Footer field drop-down menu.

4. Click in the check box to select the template(s).

5. Click OK.

Template Type of Service Plans

A service plan template can be created. These templates become available to the
end user through Chronology and are located in the Service Plan folder on the
Tree View.

Service Plans templates require effective from and to dates, and some person
merge fields. The effective dates must be created, but are not required in the
editor.
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Document Template Editor with Type Equal to Service Plans

:ﬂ Template Editor for Renetta’s Hew Service Plan - Draft (10125445)

H' & B2BsB% BIU =

M
(il
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0
¥
i
Thdl
i
5
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i
—
5
2
=
m
E
I
(=}
=
£
4

- B Document Editor lPreview ] Template Properties ]

FPe Forced page break.
5 Elernents
5 Agency
=1+ Workgraup
=1+ Service plan

D1 Effective from date < ———== Effective from date, Effective to date and a person merge
DT Effective to date

field are required in the document template Tree View

[§ First nams Last name when the document Type is Service Plans.

To Create a New Service Plan Template:

—

1. From the Template List’s Document Editor toolbar, click the New
Template button.

2. A new, blank template displays in the grid and a new Properties screen

displays below.

Select the Service Plans as the Type from the drop-down menu.

The Group field defaults to Local Agency.

Select a Category from the drop-down menu.

Enter the template name in the Name field.

Select the template format from the Format drop-down menu.

Enter Document identification, if applicable.

. The Status field defaults to Dratft.

10. Enter a desription of the template in the Description field, if applicable.

11. Click the Save and Open button.

W X NG Ww

Template Type Equal to Workgroup

Use the template type of Workgroup to create several data elements such as
check boxes, input fields, text areas and merge fields. For example, the agency
may create a workgroup template to a parent or legal guardian identifying the
specific services the agency is providing for each child.
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Document Template Editor with Type Equal to Workgroup

:ﬁ $515 Document Template Editor - 5.5.1.292 - [Template Editor. for Renett'a NEW Workzroup] . | R
X

451"5 File Edit Faormat Document Tools Window Help o]
B & YBE BIU

- [ Document Editor IHTML \ Preview\ Termplate Properties
4 State language block

FPE Forced page break —
) Elements
) Agency
5 Workgroup

fhi
Ml
o
111
111
n¥+
1
-+
i
5
@
=

THIS IS THE S5I5 TEMPLATE EDITOR

L |

To Create a New Workgroup Template:

@’)

1. From the Template List Document Editor toolbar, click the New
Template button.

2. A new, blank template displays in the grid and a new Properties screen
displays below.

3. Select Workgroup as the Type from the drop-down menu.

4. Select a Category from the drop-down menu.

5. Enter the template Name in the Name field.

6. The Group field defaults to Local Agency.

7. Select a Category from the drop-down menu.

8. Enter the template name in the Name field.

9. Select the template format from the Format drop-down menu.

10. Enter Document identification, if applicable.

11. The Status field defaults to Draft.

12. Enter a desription of the template in the Description field, if applicable.

13. Click the Save and Open button.

O Hint: See Appendix A: Template Editor Components for further information.

Social Services Information System (SSIS) Version 5.5/Version 11.3 FINAL
Training Module: Document Template Editor Page 32 of 53



SSIS Training

Merge Fields

Merge fields are data available within the application. There are workgroup level
merge fields that are based on information entered at the workgroup level. For
example, participant name, addresses, diagnosis, etc. Additionally, there is
agency level merge fields that are based on information entered in SSIS
Administration about the agency. For example, agency address, director’s name,
agency name, etc.

Template Creators can add merge fields to a template. This allows the merge
tield data to autofill with actual information entered in the application. For
example, when a worker opens a template from Chronology, all merge field data
displays as designated by the template creator.

Merge fields with a plus (+) sign designate that more merge fields are found
below that folder in the Tree View. Merge fields without plus signs can be multi-
selected from any level during the creation of a template.

The Generic Date field can only be dragged into the document once.

A new node in the tree must be created each time the generic date is used in the
document. This will allow the answers to be saved to the database correctly
when an end user creates a document from the template.

The end user cannot edit data from merge fields in the document at the time of

generation. However, data cleanup is available to help workers correct data
during document setup.

New Merge Fields (HTML)

CLIENT NAMIE: |Name without prefix.Clie

DATE: |Date.Letter Date.Docurr
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Add Fields: Workgroup

:ﬂ Add Document Template Field

Warkgroup name

Program

Start date

Close date

Close reason

3315 Workgroup #

Local agency workgroup #
Local agency case extension
|_Init

Local agency af service

Local agency of Financial responsibilicy
+ Case

+ Participant

+ Staff

Properties Values

(] 4 Cancel

To Add a Merge Field:

1. Right-click on the Workgroup folder.

Select Add Field.

The Add Document Template Field screen displays the lists of fields
which may be added.

Check the merge field to add.

When a merge field is checked, the Properties/Values section displays
additional information needed for the field.

Complete each property as desired.

Click OK.

The new merge field displays at the appropriate level in the Tree View.
Drag and drop the merge field into the appropriate place in the document.

» N

o1

O © N
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OH int: Common merge field properties:

Properties Value/Description

Required to complete document setup This field is available on most merge fields.
A designation of Yes requires a selection
from the user at the time of template
creation. Template creators should use this
designation sparingly to allow for unique
situations.

Label In most merge fields, a label should be
entered that easily identifies the intent of
the field. For example, if the user selects a
parent for a particular Name field, the
creator should attach a label of Parent so
that it provides a meaningful cue upon
setup.

Date Format Needed for all date merge fields, this allows
the template creator to designate the format
for dates in the document template.
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Conditional Text

Conditional text replaces text according to the values from merge fields so that
the text flow has continuity. For example, in a letter, the template creator may
want the text to read

This letter is regarding your child
or
This letter is regarding your children

In this case, the text would be conditional on whether one or two children were
merged in the document.

To use conditional text, template creators must enter both conditions in the tree.
In the example above, the tree must contain at least two merge fields that
represents a child.

Conditional Text

I conditional Text

First name. Child 2.wWarkgroup.Documenk
|i5 blanlk - |
displasw |
otherwise ||:|i5|:-la';.-' the Following text - |
children
K Cancel
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Adding Conditional Text:

1. Highlight the conditional text. In the example above, the conditional text
would be the word child.

Right-click on the highlighted text.

Select Set Conditional Text.

The Conditional Text entry screen displays.

Or LN

Develop the correct conditions for the action. In the example above, the
conditions are set correctly according the number of children in the two
merge fields.

Click OK.

7. The new conditional text is highlighted in grey and displays in the editor.

S
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Create a HTML Table

Use create HTML table to create simple tables. This allows template creators to
set a consistent column width in a newly-created table, add merge fields or
document elements such as input fields and/or text areas to the grid.

Tables constructed in an outside word processing program can be cut and pasted
into the template editor. Creators may find this to be a helpful shortcut when
there are extensive and/or complicated tables in the document. If this option is
used, creators must return to the word processing program to make
modifications to the table and then add the updated table to a document.

Create HTML Table Button

Create HTML Table Screen

[ﬁ Draw Table

Table properties

Mumber of rows: |3 ¥ Mumber of columns: |2 | Table width % |32 ¢| Table border: |1 =

Column properties

Header wWidth |Ban:k|;|r|:|unu:| Cu:ulu:ur| Horizonkal aligrment |'-.-'ertin:al Alignrnent ||E|
Header raw: [v 25 White Left Middle

Background color: White et R
|Gray j —

Horizontal Alignment:

|Center j

Vertical Alignment:

Middle |

[+
Table preview
Text Text
Text Text
Text Text
(0] 4 Cancel
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Table

To Create an HTML Table:

1. Click the Create HTML Table icon on the Template Editor Application
toolbar.

2. The Create HTML Table screen displays.

3. Select the number of rows for the table in the Number of rows field.

4. Select the number of columns for the table in the Number of columns
field.

5. Select the percent of the page for the table in the Table width % field.

6. Select the table border width in the Table border field.

7. In the Column properties section, designate whether a header row is
desired by checking the Header row check box.

8. Designated characteristics of the Header row by making a selection in the
Background color, Alignment and Vertical Alignment drop-down
menus.

9. In the grid, designate the Width, Background Color, Alignment, and
Vertical Alignment of each column.

10. Changes to Table and Column properties display in the Table preview
section.

11. Click OK.
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Print Preview

Users may preview a template prior to activating or printing the template to
view the page layouts.

Template Editor Windows Toolbar
WEdit Format  Document  Tools  \Window

i U

Clase l HTML

Save Template Chrl+5

Prink Ckrl+FP

Exik

Print Preview Toolbar

,n Print Pregiew - [RENETTA]
& [ -

To Access Print Preview:

From the Document Template Editor toolbar, click the Print button.
The Print Preview screen displays.
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Copy Fields

This feature allows the template creator to copy the setup of desired merge fields.
For example, if the template creator would like to have the name, DOB, address,
and phone of each distinct participant in the document, it is possible to duplicate
those fields and ensure consistancy in the document.

Merge Field Set

-5 Caregiver 1
@ First name Last name
@ Age
Ef Gender
EF PMI
& 55M

Copy Fields
R

5 Fir /- " Wiew Field Properties
B ¢ § addField

@ Gt & Delete Field

@ ol — Copy Fields

B 55

Copy Fields

:ﬂ Copy Fields

Copy fields From;

|'-.-'-.-'nrkgru::up.Caregiver 1

reate group under: Label:
|Wu:ur|<.n;|ru:uup

o4 Zancel
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Duplicate Field Lists

] Caregiver 1
@ Firsk name Last name
@ Age
E Gender
EF PMI
E 55N
5 Child 1
@ Firsk name Last name
@ Age
E Gender
EF PMI
E 55N

Copy Fields:

@’)

1.

NSl LN

Right-click on the appropriate Element node to copy the entire
list of fields.

Select Copy Fields.

The Copy Fields dialogue box displays.

Enter a label for the duplicate set of fields.

Click OK.

Both sets of fields display in the Tree View.

Drag and drop the copied fields into the document template.

OHint: Copy Fields does not function on the Workgroup, Case or Agency folders
since there can only be one workgroup, case and agency folder per document.
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Add Field Filters

Users can create a field filter to specify what information displays for selection

in the drop-down menu on the document properties screen for the end user.

For example, if the user adds a merged field for address, the user can specity the
most current address by using field filters to identify the type and effective date
of an address. Each field filter generates a list of specific filtering options. In the
example below, if the user checked Type on the Add Field Filters screen, the type
of address (e.g., Home, Work, Physical location), displays for selection as the
filter option.

The user can select one field filter at a time, but may need more than one filter
option per merge field in some situations. In this case, the user should repeat the
steps above to add additional field filters.

The user should review the field filters available for the merge field since each
merge field has unique filter options. The user can view field filters by right-
clicking on the filtered field in the Tree View and select View Field Filters.

To remove a field filter, the user should uncheck the filter by clicking in the check
box to the left of the appropriate filter and then click OK.

Add Field Filters Screen
[ﬁ Add Field Fitters - { Address )

1=
ective date

EFf
End date

In care of
Street address
ity

Properties Malues |

o4 Cancel |
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Add Field Filters Screen Once a Filter Option is Checked

¥ £.dd Field Fitters - { Address ) =13
Effective date
End date
In care of
Street address
City
Properties |'-.-'a|ues
Filter Operation Equals
Filker Walue -
i i~
Emergency nokification F
Guardian/Conseryator
Hormne:
Mailing
Other Unknown B
Pavrnent
Phywsical location o’
Delete Yalue Add Yalue (0] 4 Zancel

Add Field Filters:

1. Right-click on the appropriate Workgroup node; select Add Field Filter.

2. The Add Field Filters screen displays.

3. Select a filter option by placing a check in the box next to the desired filter
option.

4. Enter the desired Filter Operation and Filter Value in the Properties/
Values section. The user may select these values from the drop-down
menu, if one is available.

5. Repeat steps #4 and #5 to select any other field filter that displays on the

Add Field Filters screen.
6. Click OK.
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Tables of Data
The data tables are used to create a list of data that autofills with information

entered in the application. These tables can vary in length according to available
data. For example, users may create a table of data that includes all children, the
date of birth and age of each child in the workgroup.

If the table has been added to the template, then the template properties do not
change. If table properties are changed, then the template creator must drag and
drop the table into the template again and delete the old table.

Fields that are part of a table cannot be dragged individually into the editor. For
example, the TBL icon displays to the left of fields that are a part of a table.

Create Data Table

#— Wiew Field Properties

E
- hild
ﬁ & add Field
@ De
& P % Delete Field
E = Copy Fields

|'-i_l " wieww Field Filkers
E " Add Field Filker

Creake Data Table

E Expand All
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Data Table Properties

(&5 Data Table Properties (Child 4}

Leaend
Data table border: |3 =
Headings
Data table width:  [S0%
Data
Both
Available Columns [allow user to select on document setup [allows Ml Select [Separatar [Seauence
=1 child + ves ves 1z
Field rame Label |Backaround Color_[Font Color[Column [alignment  [Data Backaround Col[Dats Font Color [Dats alignment [rew Row [Sequence
F|First name Last name First name Last name Black 33% Center wwhite Black. Center o
| |oate of birth Date of birth Black. 33%  Center white Black. Center 110
BE P Black. 33%  Center white Black. Center 180
=I child's Residence ves ves S80
Label [Backaround Color[Font Color|Column [alignment  |Data Backaround Col[Data Font Color Data alignment [Mew Row [Sequence
1 Black 33%s Center wwhite Black. Center 2
it =, zip code, Foreign = City, s , zip code, Foreign ad white Black 33% Center wwhite Black. Center s
[ [rvee Type Black 53%  Center wehite Black. Center 14

oK Cancel

Table

First name Last name

[First name Last
name)

[Age]

Tree View Screen Shot

B Tvpe
—|-¥BL Client-Child 2
@ Firsk mame Lask name
B Date of birth
—-TBL Child 1 Address
B Address line 1

& Tvpe

@ City, skate, zip code, foreign address

Create a Table of Data:

&~

Gender (M or F)

[Gender (M or F)]

1. Create a folder that could have more than one selection in the document

(e.g., Children).

N

(e.g., First Name, Last Name, Age, Gender).

NS »

Click OK.

Right-click on the node level.
Select Create Data Table.
The Table Properties screen displays.
Adjust table properties if desired.

Add merge fields to that folder which will be columns in the table of data
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Copy and Save Template

Template creators can create copies of templates. This is useful when creating
new versions of old templates. It is also useful to have a template that contains
frequently-used merge fields and/or document elements. The template creator
can copy that template as often as necessary to generate other templates without
recreating the same merge fields and/or document elements.

Copy and Save Template Button

Copy and Save Template Screen

m Copy and Save Template

Template name:

Save and Open Editar Ok, Cancel

To Copy and Save Template:

1. Select the template to copy from the Template List.

2. Click the Copy and Save Template button from the Document
Template Editor Toolbar.

3. The Copy and Save Template box displays.

4. Type a new name for the copy of the original template in the
Template name field.

5. Click the OK button or Save and Open Editor button.

6. The copy of the template displays in the grid or editor depending
on your selection in Step #5.
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Import/Export a Template

Local agencies can share templates using the Import or Export template feature.
Only Local Agency templates can be imported or exported. Templates with Yes
selected for Allow JavaScript cannot be exported. Local Agency images will not
be included in the export. If the local agency wants to share an image, e.g., UCare
language block, the exporting agency can send a copy of the image to the
importing agency. The importing agency can then edit the image and set the path
to the location of the image.

Active, Inactive and Draft templates can be exported. However, the template
cannot be opened at the time of export.

To prevent corruption of a template, do not open or change the contents of the
template file. The file is saved to the agency network drive prior to exporting.
The exported file name defaults to the template name and is saved to the
network drive with the file extension .ssis. For example, the file is saved as The
Original File Name.ssis. Once exported, this file is attached to the email sent to
the importing agency.

Template creators cannot import a template to the editor with the exact same
name as an existing template in the editor. The importing agency can rename the
template prior to saving it to its network drive, but should not open the file.

The document category field is set to Imported. The importing agency can
change the category as appropriate after the import is completed.

Headers and/or footers do not import with a template since the importing agency
may want to add a header or footer template specific to the importing agency.

If the importing agency would like to use the header and/or footer used by the
exporting agency, the header and/or footer must be exported and imported
individually.

A new style sheet will be created in the importing agency with the exported style
sheet data and linked to the imported template. The style sheet will have a
default name and have the category of Style Sheet.

The Tree View remains and functions the same as that of the exported template.
Except the exported image embedded in a template does not import.
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To Import a Template:

1. Open the email from the exported agency and save the template to the
network drive.

2. From the Template List screen, click the File menu and select Import
Template.

3. From the network drive, select a template to import and click Open.

e

Change the template properties, if applicable.
5. Click Save or Save and Open or Copy and Save.

O Hints:

o Create date, Status date, and Last changed date defaults to the date and/or time
that the imported template is saved for the agency importing the template.

o Last edited by defaults to the user who saves the imported template for the agency
that is importing the template.

To Export a Template:

@’)

1. From the Template List screen, highlight a template in the grid and click
the File menu.
2. Select Export Template.

»

Save the template to the network drive.
4. Open email and attach the template to the email as an attachment prior to
sending to the importing agency.
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Preview Tab

The Preview tab is available to preview the template. Currently, users can
preview the layout of the template with the document elements entered,

view the options available in an input box, check and/or uncheck check boxes
and view images. However, headers/footers are not viewable from the Preview
tab. Template creators must use the File menu print option to preview the
headers/footers as part of the template..

Template Properties Tab

The Template Properties tab offers the user quick access to the Template
Properties screen to review and/or change the template properties, if desired.

Authorization to Allow JavaScript
Due to the complexity involved, SSIS is currently requiring all requests for

permission to Allow JavaScript to be approved. Contact the SSIS Helpdesk at
651-431-4801.

o Hint: Agencies with the authorization of Yes to Allow JavaScript, cannot export
templates. However, agencies can export and import HTML templates to other agencies
with authorization of Yes to allow JavaScript.
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Template Troubleshooting

Troubleshooting provides quick solutions to formatting problems that users may
experience when updating converted templates.

How to View Changes to the Fonts for Inputs and Text Areas

When the user types into the inputs or text areas, the font displays as the default
font on the Preview tab. The user must select Print Preview to view how the font
displays in the document.

How to Format a Merge Field

Select the desired merge field in the Tree View.

Drag and drop the merge field into the template.

Highlight the same merge field in the Template Editor.
Click on the desired formatting option, e.g., underline icon.

OHint:

o The user must complete the steps above for the underline formatting on the merge
field to work. These steps must be completed before the template’s initial save or it
will not underline.

o Click the File menu on the Windows toolbar and select print to view a print
preview of the formatted merge field.

RO,

How to Apply Formatting to an Entire Section of Text That Includes Merge
Fields

Type all of the desired text for the section.

Highlight the section of text and complete all of the formatting

(e.g., underline, bold, italic, font and font size changes).

Click on the merge field in the Tree View and drag and drop the merge
tield into the text.

o b=

OHint: To place merge field into the formatted section, the user should drop the
merge field above the section of text when first dragging the merge field in from the Tree
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View. Next, move the merge field from the dropped location in the editor to the right spot
in the text.

How to Group Merge Fields in the Tree View for Use With Autofill Tables

The desired autofill merge fields must be located under the same folder in the
Tree View. For example, from the workgroup level in the Tree View, create the
merge field, e.g., Client. From the Client folder, create additional merge fields,
e.g., First name Last name, PMI, SSN. This allows all of the fields under the
Client folder to autofill in the template when the Client merge field is dragged
into the table in the Editor.

How to Have Multiple Races, Already Enter in SSIS, Autofill into a Template

To have all of the races entered in the application autofill into a document, create
a table and drag the race merge field into the table. If applicable, drag the tribe or
ethnicity and Tribal enrollment status merge fields into the table as well.

OHint: Be sure to create a table with the appropriate number of cells for one merge
field per cell. Also, hide the table borders as necessary.
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Editor Components
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